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1. Scope

This document defines the management tree andddes\Non which the OMA DM protocol acts. A standzediway to
describe these Nodes is also specified.
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3. Terminology and Conventions

3.1 Conventions

The key words “MUST”, “MUST NOT”, “REQUIRED”, “SHAL", “SHALL NOT”, “SHOULD”, “SHOULD NOT",
“RECOMMENDED”, “MAY”, and “OPTIONAL" in this documet are to be interpreted as described in [RFC2119].

All sections and appendixes, except “Scope” antrdbiuction”, are normative, unless they are exijiéghdicated to be

informative.

Any reference to components of the DTD's or XMLpgits is specified in thiypeface

3.2 Definitions

Access Control List

Description Framework

DM Server

Dynamic Node

Interior Node

Leaf Node

M anagement Object

Management Object
Identifier
Management Tree

Node

Permanent Node

Server ldentifier

A list of identifiers and access rights associatéti each identifier.
A specification for how to describe the managensgntax and semantics for a particular device type.

A network based entity that issues OMA DM commatoddevices and correctly interprets responses sent
from the devices.

A Node is dynamic if the DDF property Scope isteeDynamic, or if the Scope property is unspecified

A Node that may have child Nodes, but cannot stasevalue. The Format property of an Interior Nade
node.

A Node that can store a value, but cannot havel tfdldes. The Format property of a Leaf Node is not
node.

A Management Object is a subtree of the Manageifre® which is intended to be a (possibly singleton)
collection of Nodes which are related in some viEgyr.example, the ./Devinfo Nodes form a Management
Object. A simple Management Object may consistnef single Node.

The Type property describing the kind of data st@e the Management Object’s value.
The mechanism by which the management client iotesaith the device, e.g. by storing and retrieving

values from it and by manipulating the properti€#,dor example the access control lists.

A Node is a single element in a Management Treerd'han be two kinds of Nodes in a Management
Tree: Interior Nodes and Leaf Nodes. The Formgpgnty of a Node provides information about whether
a Node is a leaf or an Interior Node.

A Node is permanent if the DDF property Scope ise®ermanent. If a Node is not permanent, it is
dynamic. A permanent Node can never be deleted.

The OMA DM internal name for a DM Server. A DM Ser\vs associated with an existing Server
Identifier in a device through OMA DM authenticatio

3.3 Abbreviations

ACL Access Control List
DDF Device Description Framework
OMA Open Mobile Alliance

0 2010 Open Mobile Alliance Ltd. All Rights Reserved.
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4. Introduction

Other OMA DM specifications define the syntax arthantics of the OMA DM protocol. However, the usedéss of such a
protocol would be limited if the managed entitieslevices required different data formats and diggd different behaviors.

Since device manufacturers will always develop favetions in their devices and since these funetioften are
proprietary, no standardized Management Objectt &4 them. To make these functions managealleeimevices that
have them, a device description framework is nedldadcan provide servers with the necessary irdtion they must have
in order to manage the new functions. The intentiith this framework is that device manufactureit publish
descriptions of their devices as they enter thekataOrganizations operating DM Servers should thrdg have to feed the
new description to their servers for them to autiically recognize and manage the new functionsiéndevices.

0 2010 Open Mobile Alliance Ltd. All Rights Reserved.
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5. The Management Tree

Each device that supports OMA DM MUST contain a Elggment Tree. The Management Tree organizes alablea
Management Objects in the device as a hierarchiealstructure where all Nodes can be uniquelyessdd with a URI. The
following figure shows an example Management Tree.

P
The Root
H./!l
—

DMAcc OSGi Vendor Operator

Ring
signals

Screer
saver

MyMgmServer

Figure 1. Example M anagement Tree

The URI for a node is constructed by starting atdhvice root and, as the tree is traversed dowhetdlode in question,

each Node name is appended to the previous onas isas the delimiting character. In the OMA DNMapocol [DMPRO],
the URI used to address Nodes MUST be a relative UR

To access the xyzinc Node in the Management Treeeala server would present the addrgBdviAcc/xyzinc  , or
DMAcc/xyzinc . Note that the URI MUST be given with the rootloé Management Tree as the starting point.

URI used in OMA DM MAY be treated and interpretedicase sensitive. Node names SHOULD be chosertlsaich
resulting URI strings differ in more than just tteese of individual letters. Implementations, evidneiating and interpreting
URIs as case insensitive, SHALL preserve the casgmbols in the names of dynamically created Nodes

Client device SHOULD indicate the Node name cassitieity in the DDF using the CaseSense elemespasified in
Section 9.4.3.

URI used in OMA DM MUST use the UTF-8 character. set
The following restrictions on URI syntax are inteddo simplify the parsing of URI's.

* A URI MUST NOT end with the delimiter "/*. Note thehis implies that the root Node MUST be denoted.4and
not "./".

A URI MUST NOT be constructed using the characéguence "../". The character sequence "./* MUST MOT
used anywhere else but in the beginning of a URI.

0 2010 Open Mobile Alliance Ltd. All Rights Reserved.
Used with the permission of the Open Mobile Alliance Ltd. under the terms as stated in this document.



OMA-TS-DM_TND-V1_3-20100525-C Page 10 (52)

6. Nodes

6.1 Common characteristics of Nodes

Nodes are the entities which can be manipulatetidnyagement actions carried over the OMA DM prota&diode can be
as small as an integer or a large and complexalikackground picture or screen saver. The OMA DMamol is agnostic
about the contents, or values, of the Nodes aadisttbe Leaf Node values as opaque data.

An Interior Node can have an unlimited number ofdcNodes linked to it in such a way that the coatelcollection of all
Nodes in a management database forms a tree sguBfach Node in a tree MUST have a unique URI.

Each Node has properties associated with it; theggerties are defined in 7.1. All properties, gtabe ACL, are valid only
for the Node to which they are associated.

6.2 Details of the Management Tree

As mentioned before the complete structure of aliiés and the root (the device itself) forms a tb#d.Servers can explore
the structure of the tree by using the GET comménlte accessed Node is an Interior Node, a fistlachild Node names
is returned. If the Interior Node has no childrarempty list of child Node names is returned, €@ata/>. If the Node is a
Leaf Node it MUST have a value, which couldrhgl , and this value is returned. A DM Server MAY maintinformation
about its current position in the Management Tree.

Nodes with the Format property setnmde are defined as Interior Nodes. Nodes that aréntetior Nodes are defined as
Leaf Nodes. Interior Nodes can have 0 or more ohildLeaf Nodes cannot have children.

The Management Tree can be extended at run-time.i§ Hone with the Add or Replace command and heth Interior
Nodes and new Leaf Nodes can be created. The pafrany new Node MUST be an Interior Node. The devself can
also extend the Management Tree. This could happenresult of user input or by attaching the skime of accessory to
the device.

6.2.1  Addressing object values

Node values are addressed by presenting a reldRVédor the requested Node. The base URI [RFC2B88FT be the root
of the Management Tree in the device. If a valid Wpresented along with a command for which tiieent Server
Identifier has sufficient access rights, the comdheUST be executed. The client MUST respond witlappropriate status
code. If the command results in a value that Iset@ent back to the server, then this value MUSpareof the response.
The type of the value is returned as part of thearirdormation as specified in [AMT].

Example:
The following Get command:

<Get>
<CmdID>4</CmdID>
<ltem>
<Target>
<LocURI>Vendor/Ring_signals/Default_ring</ LocURI>
</Target>
</lItem>
</Get>

could receive a response like this:

<Results>
<CmdRef>4</CmdRef>
<CmdID>7</CmdID>
<|tem>
<Data>MyOwnRing</Data>

0 2010 Open Mobile Alliance Ltd. All Rights Reserved.
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</ltem>
</Results>

6.2.2  Addressing Interior Node child lists

Interior Node child lists are addressed in the saagas Node values. The list of children is reédras an unordered list of
names. The individual names in the list are sepdray the character “/”. A returned child list e formatode in the
meta information of the result. Note that the ‘iacacter MUST NOT be part of any Node names acegridi [RFC2396].

Example:
The following Get command:

<Get>
<CmdID>4</CmdID>
<ltem>
<Target>
<LocURI>Vendor/Ring_signals</LocURI>
</Target>
</lItem>
</Get>

could receive a response like this:

<Results>
<CmdRef>4</CmdRef>
<CmdID>7</CmdID>
<ltem>
<Meta>
<Format xmIns="syncml:metinf’>node</Format >
<Type xmins="syncml:metinf’>text/plain</Ty pe>
</Meta>
<Data>Default_ring/Ring1/Ring2/Ring3/Ring4</ Data>
</ltem>
</Results>

If a Get command is issued on an Interior Node dloas not have any children the client MUST retanrempty child list,
e.g. <Data/>, and the status code (208)

6.2.3 Permanent and Dynamic Nodes
Nodes in the Management Tree can be either perrhaneynamic.

Permanent Nodes are typically built in at devicenafacture. Permanent Nodes can also be tempoeatilgd to a device by,
for instance, connecting new accessory hardwareieider, a DM Server cannot create or delete pernidhedes at

runtime. An attempt by a DM Server to delete a @eremt Node will return stat{g05) Command not allowed

The same status code will also be returned faattdimpts to modify the Name property of a permahiate.

Dynamic Nodes can be created and deleted at ruttyniEM Servers. The Add command is used to createNodes. The
Delete command is used to delete Dynamic Nodeskutigeir properties. If a deleted Node has chifgiies. is an Interior
Node, the children MUST also be deleted.

Note that a permanent node MAY be the child ofegithh dynamic or a permanent node. In such casgeetheanent child
node is created at the same time its parent notleased.

The complete layout of the permanent Nodes in taeddement Tree is reflected in the device desoripti
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6.2.4  Adding Dynamic Nodes

As stated in the previous section the Add commandéd to create new Nodes. The definition of thd 2ommand in
[DMPRO] states that the Node addressed MUST NO#3t éxithe tree. The name of the newly created N&idALL be the
last segment of the URI presented in the Targetete of the Add command. Note that devices mightheaarious
constraints as to the lengths of the URI used tvesms the Management Tree. These constraints M@S&dorded in the
./DevDetail Management Object as specified in [DMSTDOBJ].

Example:
The following Add command:

<Add>
<CmdID>5</CmdID>
<ltem>
<Meta>
<Format xmIns="syncml:metinf’>b64</Format>
<Type xmiIns="syncml:metinf’>audio/myMelody Type</Type>
</Meta>
<Target>
<LocURI>Vendor/Ring_signals/My_beep</LocUR >
</Target>
<Data>jkhdsfKJhdsf89374h</Data>
</lItem>
</Add>

would create a previously non-existing Node calad beep as a child Node to the Interior Node
Vendor/Ring_signals

When a Node is created, all the properties thatNlide supports are automatically created by tibatciThose property
values that depend on information present in thé &dReplace command, e.g. Name, are assignedvhksss. Properties
with a default value (e.g. Name) or a value thaisomatically updated by the client (e.g. Size)aso assigned appropriate
value at Node creation. Other properties will hagevalue.

Interior Nodes are created in the same way. THerdifice is that the server MUST explicitly say ttiet new Node is an
Interior Node by including a Meta element with arRat value ohode .

Example:

<Add>
<CmdID>5</CmdID>
<ltem>
<Target>
<LocURI>Vendor/Ring_signals/MyOwnSongs</Lo cURI>
</Target>
<Meta>
<Format xmiIns="syncml:metinf’>node</Format >
</Meta>
</ltem>
</Add>

6.2.5 Protecting Dynamic Nodes

Some Dynamic Nodes can be part of a larger conéext,only have meaning in this context. Alterndtivéhe context (a
Management Object) might become useless if a dethist, e.g. by the deletion of a dynamic LeafiNoThis could for
instance be the address of an SMTP server forraaieManagement Object. To protect this kind of Bdicbm deletion and
thus maintain the integrity of the context, the DY¥bpertyAccessType can be set so that the Delete command is
excluded. This means that a Delete command willfidh status(405) Command not allowed
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Note that this is not the same thing as a permaxede. A Node protected by thecessType property can still be
deleted if it is part of a sub-tree that is beimteted. The Delete command acts strictly on theeNbid addressed at, and if
that Node is a dynamic Interior Node it will be eteld along with all its child Nodes. If any of teeshild Nodes have the
AccessType property set to exclude Delete they will be deletrgway. The following table summarizes the pratect
mechanisms for Dynamic Nodes.

How the Node is addressed

Directly by URI in a Delete | Indirectly, as a child of a Node
command being deleted

What Delete Deleted Deleted

AccessType allowed

specifies for the |"nojete not Not Deleted Deleted

Node allowed

Table 1: Protection mechanismsfor Dynamic Nodes

Note that this mechanism is completely independétite ACL.

See chapter 9 for more information on DDF propsrtie
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7. Properties of Nodes
7.1 Definition

Properties of Nodes are used to provide meta irdtiom about the Node in question. All propertieshis section are run-
time properties, e.g. they are available duringifeéme of their associated Node. Section 9.4ald with the properties
used in the context of device descriptions, whiegh@mpletely separate from the run-time propedesdt with here.

Property Explanation

ACL Access Control List

Format Specifies how Node values should be intézdre

Name The name of the Node in the tree

Size Size of the Node value in bytes

Title Human readable name

TStamp Time stamp, date and time of last change

Type The MIME type of a Leaf Node’s value or a URNresenting the Management Object
identifier for Interior Nodes which root a Managarmh®bject sub-tree

VerNo Version number, automatically incrementedath modification

Table 2: Run-time properties

It MUST NOT be possible to create new propertiearirexisting device.

7.2 Supported properties

Devices MAY support different sets of propertiesntg properties are OPTIONAL for a device to implaméut all are
REQUIRED for servers. The following table defingeperty support for devices.

Property Device support
ACL MUST
Format MUST
Name MUST
Size MAY for Leaf Nodes
MUST NOT for Interior Nodes
Title MAY
TStamp MAY
Type MUST
VerNo MAY

Table 3: Property support for devices

7.3 Property addressing

The properties of a Node are addressed by appefgiop=<property _name> to the Node’s URI. For instance, to
access the ACL of an OMA DM account a DM Serverdase one of these URIs:

./DMAcc/xyzInc?prop=ACL
DMAcc/xyzinc?prop=ACL

If a server addresses an unsupported propertyl@vige, an error is returned in the form of(466) Optional
feature not supported status
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7.4 Property values

Property values MUST be transported by OMA DM ad-t8Tencoded strings. Numerical property values MWST
converted to numerical strings, expressed in ddcitia NOT RECOMMENDED to use a <Meta> element ooperty
values.

It is unnecessary to use a <Meta> element for ptppalues because they are all strings. This méaatsthey would all
have the same <Meta>, like this:

<Meta>
<Format xmIns="syncml:metinf’>chr</Format>
<Type xmins="syncml:metinf'>text/plain</Type>
</Meta>

7.5 Operations on properties

The following table defines the allowed operatiforseach property. An operation on a property isiegent to an OMA
DM command that is performed by a server on the &fRlhe property.

Property Applicable Commands Comment

ACL Get, Replace Get and Replace are the only waidmands for
ACL manipulation. Note that Replace always
replaces the complete ACL.

Format Get Automatically updated by Add and Replace
commands on the associated Node.

Name Get, Replace A Replace is equivalent to ameraf the Node.

Size Get Automatically updated by the device.

Title Get, Replace Only updated by server actiarsoftware version
changes.

TStamp Get Automatically updated by the device.

Type Get Automatically updated by Add and Replace
commands on the associated Leaf Node.

VerNo Get Automatically updated by the device.

Table 4: Allowed operations on properties

Properties do not support the Add command. All naémiy properties, and those optional propertiesdtdevice
implements, MUST be automatically created whenwa Nede is created. The values of the newly creblede properties
are all empty, e.g<Data/> . However, Node properties that have a defaultejadu are automatically updated by the
device, MUST be assigned appropriate values byl¢véece.

Use of an unsupported command on a property vélilitén an error and the stat(#05) Command not allowed is
returned.

Property values MAY also change for reasons ofem tirect server operations. For instance, somieeeMAY allow the
user to modify the ACL. If this occurs and the aevsupports the TStamp or VerNo properties, thed&Mbe updated.

7.5.1 Properties of Permanent Nodes

The semantics of most properties are independahegiermanent/dynamic status of the Node to wiiek are associated.
The exception is the Name property, which MUST NégTchanged for permanent Nodes. Any attempt toparuch a
change SHALL fail.
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7.6 Scope of properties

With the exception of the ACL property, all propestare only applicable to the Node with which they associated.
Properties are individual characteristics of eacklél There SHALL be no inheritance of property ealimplied or
specified, other than for the ACL property.

7.7 Detailed description of properties
7.7.1 ACL

The ACL property has some unique characteristiosnadompared to the other properties.

The access rights granted by an ACL are grant&kteer Identifiers and not to the URI, IP addrassestificate of a DM
Server. The Server Identifier is an OMA DM specifame for a server. A management session is assteisth a DM
Server Identifier through OMA DM authentication [[(B#C]. All management commands received in one@esse
assumed to originate from the same DM Server.

7.7.1.1 ACL and inheritance

Every Node MUST implement the ACL property, butrthean be no guarantee that the ACL of every Nedeshvalue
assigned to it. However, the root Node MUST alwagge an ACL value. If a server performs a managémegeration on a
Node with no value set on the ACL the DM Client MUBok at the ACL of the parent Node for a valufthe parent does
not have a value for the ACL, the DM Client MUS Dkoat the ACL of the parent’s parent, and so oil antACL value is
found. This search will always result in a founduessince the root Node MUST have an assigned A&uer This way,
Nodes can inherit ACL settings from one of theicestors.

Inheritance only takes place if there is no valssigned to the complete ACL property, i.e. theeerer commands present.
As soon as any value for an ACL property is preséig value is the only valid one for the currblatde. ACL values
MUST NOT be constructed by concatenation of vafu@® the current Node and its ancestors.

If an ACL does not contain any Server Identifier &particular command, then this command MUST Nb@Tpresent in the
ACL. Inheritance does not take place on a per conthiasis. Whenever an ACL is changed, by a sendey the client
itself, care needs to be taken so that command siatieout Server Identifiers are not stored intlegy ACL, resulting in an
improperly formatted ACL.

If the ACL for a Node has no value, when a Get camdhis performed to get the ACL property of thisieathe client
MUST check its parent node and return the inhe®€d to the server. If the parent does not havelae/for the ACL, the
device MUST look at the ACL of the parent’s paremtg so on until an ACL value is found, then therdl MUST return the
status cod€217) OK with Inherited ACL to the server.

7.7.1.2 The root ACL value

The value of the root is special — it is owned gy tlevice. It is also the only Node that MUST hawalue assigned to the
ACL. The default value for the root ACL SHOULD Beld=*&Get=*.

To ensure that any authenticated server alwayexi@mmd the Management Tree, the root ACL valué¢HerAdd command
SHOULD NOT be changed. The ACL value for the Addharand in the root ACL SHOULD be ". Any attempt by a
server to modify this ACL value MAY fail with théatus code (405) Command not allowed

7.7.1.3 Changing the ACL
The rules for changing the ACL of a Node are défdrfor Interior Nodes and Leaf Nodes.

* Interior Nodes
The ACL is valid for the Node and all propertieattthe Node may have, i.e. the right to accesa@ieis
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controlled by the ACL itself. If a Server Identifieas Replace access rights according to the N@lethAen this
Server Identifier can change the ACL value.

* Leaf Nodes
The ACL is valid for the Node value and all propestthat the Node may have, except the ACL propesgjf. If a
Server Identifier has Replace access rights aaugitdi the Node ACL then this Server Identifier clwange the
Node value and all property values, but not the A@lue.

However, for both types of Nodes the right to cheatige ACL of the Node is also controlled by the AGflthe parent Node.
Note that any parent Node is by definition an listeNode. This makes it possible for a Server Idiemtwith sufficient
access to a parent Node to take control of a tfdlde. This is a two-step process where the seingtrchanges the ACL of
the child Node and then can access the Node V@tief children or other Node properties. Notettbven if a server has
total access to the parent Node according to thenpga ACL, this does not imply direct access te ¢thild Node value. To
change a child Node value the child ACL value MU&Tchanged first.

The ability for a Server Identifier with accessatparent Node to take control of a child Node iegpthat any Server
Identifier with control of the root Node can takentrol of the complete Management Tree. Doing sola&borious process
that involves many separate management commanalg issued by the server. To avoid such laborioasgss, once the
client received the command to change the ACL vafteNode, the client MUST allow the server torgpathe ACL of
this node in case the server has the Replaceafdts parent or ancestor Node. It also impliest tnless two Server
Identifiers agree about passing authority betwlemt transition of authority cannot take place sTaiso makes ‘hostile
takeovers’ of devices impossible. To provide the eser with the ability to change which Server L that controls the
root Node some devices MAY implement a Ul for thispose.

Servers can explicitly set ACL values by performamBeplace operation on the ACL property of anggilode. A
successful completion of such an operation is digshdoy an(200) OK status code. If the operation fails due to lack of
device memory status co@20) Device full is returned. In addition, if the reason for fadlus access violation the
status cod¢425) Permission denied is returned.

If a server successfully creates a new Node wighAtid command the value of the Node’s ACL propéertiyitially set to no
value, e.g<Data/>.  This means that the value is inherited from thepaNode. However, there is one exception to this
rule. If a server is adding an Interior Node andsinot have Replace access rights on the parémé oew Node then the
device MUST automatically set the ACL of the newdd o that the creating server has Add, DeleteRamdace rights on
the new Node.

In cases where the above rule does not app Y RESOMMENDED that the current Server Identifier egjply set the new
Node ACL. This is achieved by using a Replace condran the ACL URI of the new Node. The current seiSHOULD
set the ACL value so that itself has Delete, GetReplace access.

Note that since the only command available to chaargACL is Replace, all existing Server Identfiand access rights are
overwritten. If a server wishes to keep the exgtntries in an ACL it MUST read the ACL, perforhetneeded changes
and then Replace the existing ACL with the new one.

7.7.1.4 Deletion of DM Account

When a DM Account is to be deleted from the dewvike,Management Tree MUST be scanned for NodesA@ih's held
by the soon to be deleted Server Identifier cowrdmg to the DM account. All the references ts tBerver Identifier
MUST be deleted. In the event that this procesovam the only Server Identifier for a particulangoand on a particular
Node, then this command is removed from the ACLilitss Node. Note that if all commands are removethfan ACL in
this process, resulting in an ACL with no values &KCL becomes inherited (see Section 7.7.1.1).

In the event that this process removes the Sedesttifier for Replace and Delete command on aadi Node, the DM
Client MUST scan all of its ancestor Nodes to chebkther any of them has Replace or Delete riggggyaed to any DM
Server. If no DM Server has Replace or Delete achghts to all of the ancestor Nodes of this orgdiNode, then the
‘Replace=*" access rights MUST be added into theLA@ this Node.

In the event that this process removes the onlye®édentifier for a command in the root ACL, th€A for that command
MUST become "*" or a suitable factory default. ThEsn order to comply with the restriction on ttomt ACL specified in
Section 7.7.1.2 in this document.
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7.7.1.5 ACL syntax

The ACL structure is a list of Server Identifierbave each identifier is associated with a list 8ADM command names
[DMPROQO]. The right to perform a command is granifeath identifier is associated with the name of thenmand that is to
be performed.

The Server Identifier can also have a wildcard ealssigned to it. This means that any Server liilemtised to access the
Node and/or its properties is granted access.

ACL are carried over OMA DM as a string. The strMyST be formatted according to the following siemgtammar.
<acl> ::= <acl-value> | "No value”
<acl-value> ::= <acl-entry> | <acl-value> & <acl-en try>
<acl-entry> ::= <command> = <server-identifiers>

<server-identifiers> ::= <server-identifier> | <ser ver-identifier> +
<server-identifiers>

<server-identifier> ::= * | “All printable characte rs except ‘=, ‘&',
* '+’ or white-space characters.”

<command> ::= Add | Delete | Exec | Get | Replace

For uniqueness, itis RECOMMENDED that the Serdentifier contain the domain name of the server.gfficiency
reasons it is also RECOMMENDED that it is kept lasrsas possible. The wildcard value for a Serdentifier is character
*_If a <server-identifier> has the value ¥, then there SHOULD NOT be anyesthserver-identifier >
values associated with this command in the cud&it. If an ACL entry contains both a wild card, ,*and a<server-

identifier >, the access right granted by thserver-identifier> is overridden by the wild card.
Example ACL value:

Add=www.sonera.fi-8765&Delete=www.sonera.fi-
8765&Replace=www.sonera.fi-8765+321_ibm.com&Get=*

There is no ACL representation for the Copy comma@dpy exists as a command on its own mainly fiiciency reasons.
Any result of a Copy command can always be crelayesl sequence of other commands. To successfidlyuex a Copy, a
server needs to have the correct access rightedarquivalent Add, Delete, Get, and Replace condsian

7.7.1.6 ACL Example

Consider the following Management Tree:
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/

Add=*&Get=*
NodeB
NodeA Get=ServerA&
Get=ServerC& Replace=ServerA NodeC
Replace=ServerC Get=ServerA&
Replace=ServerA
Node2 Node3
ACL= Get=ServerB&Replace=ServerB&Delete=ServerB
Nodel
Get=*
Node4 Node5
ACL= Get=ServerA&Replace=Server

A&Get=ServerB

Error!

Figure 2: Example M anagement Treewith ACLs

The following statements about this Management @redrue:

* Any server can Get the value .éflodeA/Nodel |, but only ServerC can modiffNodeA/Nodel?prop=ACL
in one operation.

* No server can directly Delete or Replace the vafuéNodeA/Nodel
* A Get request oNodeA/Nodel?prop=ACL will return Get=* .

* A Getrequest orfNodeB/Node3/Node4?prop=ACL will return
Get=ServerB&Replace=ServerB&Delete=ServerB, and wit h the status code (217) OK

with Inherited ACL

* A Replace request afNodeB/Node3/Node5 by ServerA will be successful.

7.7.2 Format

The Format property always maintains informationudtihe data format of the current Nodsue. Allowed formats are
defined in [META].

The entity setting the value MUST supply the forim&rmation in the same command that is used ttheevalue. The
format information is carried (in the DM messaggXite Format tag within the Meta element [META]tbé Item that has
the data to be set. The property value is repreddny a string. See section 7.7.7.1 for an example.

Note that Interior Nodes MUST hawede as the Format value.

When a Node’s native value is B64-encoded bin&ey valueb64 is used as the node Format property and a Metadtor
[META] value of “b64” MAY be used when sent over Dpfotocol. When data has a binary form (as inditaiethe Mime
Type in the Meta Type), and the data is sent ot Xthen the Meta Format MUST 4. The recipient of this data
then decodes the data and associates the nodetRopartybin  with the data so that any time a Get command on the
Format property of this Node is executed, the raspdVUST béin.
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In effect, the binary data exists as binary onstiever, and is processed as binary on the clieMAY be only temporarily
encoded in Base64 if it needs to be sent over XML.

When binary data is sent over WBXML.:
» the Meta Format MUST biein , if the Base64 encoding is not used,
* the Meta Format MUST big64, if the Base64 encoding is used.

In either case, the Base64 encoding is used omlggitransport. The Management Tree property FoiaST bebin for
this data.

7.7.3 Name

This property reflects the name of the Node to Wwiitidelongs. This is the name by which the Nodeddressed in the
Management Tree. The Name property is a string avitteximum length that is defined in ./DevDetailllMRaxSegLen as
described in [DMSTDOBJ].

When a new Node is created, the value of the Nanmepty MUST be assigned with the value of lastsext in the Target
URI.

This property supports the Replace command. WHeepdace command for this property is received leydévice, it

MUST first check that the result of the commandgdoet lead to an inconsistent tree, e.g. duplidatge names, before the
command is executed. Since it is only the last sggraf the current Node’s URI that is changed sis@rch for possible
duplicate names can be limited to the siblingshefdurrent Node.

7.7.4 Size

The Size property is used for the current sizénefNode value. The property value is a 32 bit ureignteger.
The value of the Size property MUST be equal tosilze of the Node value in bytes and the cliené$ponsible to do that.

Note that the Size property of a binary data v&llST indicate the size in bytes of the actual (woeled) value, and NOT
the length of a Base64 encoded string that mayayr mot have been used to convey the data over XML.

Also note that the Meta Size tag used in conveglatg always indicates the size of the data in tegsege. If the message
is in XML and the data is binary, then the datd bél encoded. Consequently, the Meta Size oftthattais encoded d¥64
is the length of the Base64 encoded string.

7.7.5 Title

The Title property is used to store a human reagaphanumeric string that provides some inforamasibout the Node to
which this property belongs. The Title propertgistring with a maximum length of 255 bytes.

7.7.6 TStamp

This property is a record of the date and timeheflast change in value of the Node which hasptiperty. The value is
represented by a string containing a UTC base@§B®1] basic format, complete representation cita dnd time value,
e.g. 20010711T163817Z means July 11, 2001 at 16h88 minutes and 17 seconds.

7.7.7 Type

The Type property is inspired by the concept ottypata in programming languages. For leaf ohjdutsType property
describes the kind of data stored as the objeeatisev For interior objects, the Type propertyniifées the collection rooted
at that Interior Node.
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7.7.7.1 Leaf objects

The Type property of a leaf object is always thélItype of the current object value. Allowed tyae defined in [AMT].
The entity setting the value MUST supply the typimation in the same command that is used ttheetalue. The Type
tag in the Meta information carries the MIME typédarmation for the Item. The property value is egEmted by a string.

An object’s description MAY specify that the objeetn store more than one MIME type. Consequentigraer that
modifies an object’s value MUST supply the MIME ¢ypf the data when the object value is set.

Example:

The following Add command illustrates how the Tygred Format properties are set:

<Add>
<CmdID>4</CmdID>
<ltem>
<Target>
<LocURI>Vendor/ISP/lyyy/GWName</LocURI>
</Target>
<Meta>
<Format xmIns="syncml:metinf’>chr</Format>
<Type xmins="syncml:metinf’>text/plain</Ty pe>
</Meta>
<Data>www.yyy.se</Data>
</ltem>
</Add>
7.7.7.2 Interior objects

The Type property of an interior object is repreéedrby a string. The property MAY have no value.aiWlthe property does
have a value, it MUST represent the Managementdédhjentifier of the collection of objects rootettlae current object.

The Management Object Identifier SHOULD be a URhé&iY the Management Object Identifier is registéngthe Open
Mobile Naming Authority [OMNA], the identifier wilmost likely be a URN. Some examples are: urn:ornama-
fumo:1.0, or urn:oma:mo:oma-imps:1.0.

Management Object Identifiers not registered by@pen Mobile Naming Authority MAY use the followingversed
domain name scheme:

Reversed Domain Management Object Identifiers

A reversed domain Management Object Identifienisnfed by combining the reversed domain name obwheer with the
name and version of the object, e.g. “com.compdng&’roductY”. The syntax is as follows:

<management_object_name> ::= <reversed-
domain>/<major>.<minor>/<name>[/<name>]*

<reversed-domain> ::= “reversed internet domain nam e
<major> ::= [1-9][0-9]*
<minor> ::= 0 | [1-9][0-9]*
<pame> ::= alphanum
NOTES:

1. The reversed domain is as used in some programianiigyiages to name classes uniquely, and MAY inchutbe
domains, e.g. “com.companyx.producty” (a fictioeghmple).
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2. The major and minor elements of the version arsidened unsigned integer counters, without leadergs.

3. For simplicity and portability, each name elementurrently restricted to alphanumeric charactéfdphanum is
defined in [RFC2396].)

The domain name of the object owner specifies agspace. In that namespace, the Management Obgtifler MUST
be unique. A server that wishes to obtain the Bil2Fcorresponding to the object does so in an enp@ntation-specific
way. The server MAY maintain a local repositoryOidF files describing objects that are managedieyserver. It is
RECOMMENDED that manufacturers and standards orgdinns maintain web-accessible repositories afétidmcuments.
Then servers could be implemented to obtain DO#s fdutomatically (as needed) by maintaining a smagiping from
organization (domain) to the web location (URLYldé DDF file, given the Management Object Identifidlternatively,
another technique could be specified in a futursiva of OMA DM specifications.

Note that a client may store DDF files internal.Management Object could be designed to providersistent location
within the Management Tree for these descriptions.

When an object has a DDF description, and an amrcekthat object also has a DDF description, the descriptions
SHOULD be consistent. For example, the OMA DM Aacbinformation is described by a specific DDF.manufacturer
MAY supply a DDF file for an entire device, whicbreesponds to the DDF of the root. The informatiothe root DDF
which describes the OMA DM Account information SHOWcorrespond to the description in the Managen@rject
Identifier of the DMAcc object. In the case of@ndict, the more local Management Object IdentifdUST be used.

The server provides the Management Object Identifithe Type property when creating interior olgesee the example
below). Device manufacturers would typically pawiit for permanent objects.

Example:
The following Add command illustrates how the Typeperty might be set when an interior object &ated:

<Add>
<CmdID>3</CmdID>
<ltem>
<Target>
<LocURI>Vendor/ISP/yyy/Profile</LocURI>
</Target>
<Meta>
<Format xmiIns="syncml:metinf’>node</Format >
<Type xmins="syncml:metinf’>se.yyy.dm/2.10 /Profile/Class1</Type>
</Meta>
</lItem>
</Add>

Note that in the example above, a sub-domain id (dm.yyy.se), the major version is 2 (two), theamiversion is 10 (ten),
and the name is “Profile/Class1”.

The Management Object Identifier is intended taibeful under the following circumstances. A DM&erMAY use DDF
definition files from different devices to identifyhich positions the different devices stores M@&magnt Objects. A DM
Server that examines the Management Tree in a@euaic use the Management Object Identifier to nk#aiescription of
an object that was previously unknown to this serviénis situation could arise many ways, for exémp

» A different DM Server in the same organization rhaye created the collection of objects in the devic
* A DM Server from a different organization may haveated the collection of objects in the device.

» The collection of objects could have been addeati@éalevice’s Management Tree by software in théceatself,
perhaps in response to the addition of a pieceaafare to the device (e.g. a card inserted intexgansion slot).
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7.7.8 VerNo

VerNo is a 16 bit unsigned integer. Each time adNwith this property changes value, through a mement operation or
otherevent, this value SHALL be incremented. If piheperty value has reached Fk&Rnd then is incremented, it SHALL
return to 000¢;.
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8. Device Management Tree Exchange

The Management Tree is a hierarchical arrangenfananaged objects in a device, which defines theagament view of
the device. In order to effectively manage a device DM Server SHOULD be able to manage relevartspf the
Management Tree in the device. Without knowinghNfamagement Tree, the DM server would not be abbetess a
specific managed object in the device and henextfely manage the device.

The method for exchanging Management Tree infolnatietween a DM client and a DM server involves:
* Representing the wanted information from the twéthout loss of information about its hierarchistlucture
» Sendingitin an OMA DM command to the recipient.
Management Tree information can be representedielntred by using an XML representation as describ section 9.

The OMA DM specifications allow the DM server tadadeplace and delete parts of a Management Traesiimgle package,
but to get the information from the client DM sarvequires multiple round trips. The following Sectspecifies a way to
Get a part of a Management Tree in a single package.

8.1 Requesting a Part of a Management Tree

The DM server uses tteetcommand with an attribute “Struct”, “StructDataf,“TNDS” in the <URI> to retrieve the
Management Tree information identified by the bttte. The DM Client MUST send all the requestedrimfation of the
whole sub-tree which begins at the <URI> node tatvkhe DM server has a read access right as $pebaif the table
below.

In case this feature is not supported the clientSWiWeturn status cod®6 (Optional Feature Not Supported)

The DM Server uses thget command with attribute “MORoot” in the <URI> tatrieve the roots of MO occurrences
identified by the MO identifier. The DM Client MUSreturn the requested information for all the M@#th the specified
MO identifier which were found in the whole subédnehich begins at the <URI> node.

The DM Server uses thiget command with attribute “MORootData” in the <URIerietrieve the roots of MO occurrences
identified by the MO identifier along with the resgted Leaf Nodes’ data and URI. The DM Client MU8ilrn the
requested information for all the MOs with the dffed MO identifier which were found in the wholalstree which begins
at the <URI> node.

The attributes are added to the URI specified éltdm element inside th&et command. Th&et command and the URI
in it have the following format:

GET <URI>?list=<attribute>

Where the attribute is addressed by appen@irigst =<at t ri but e> to the retrieved Node’s URI.
When the 'list=<attribute>' element is specifiedUST contain exactly one attribute.

See Appendix C for detailed examples

The valid values for <attribute> are:

Attribute Description
Struct The structure of a Management Tree is retlirwithout any data.
StructData The structure of the Management Treetisned, with the Leaf Nodes data.
TNDS The returned data is a serialized sub-tresefised in [DMTNDS].
MORoot The roots of all MO occurrences correspogdmthe specified MO

identifier are returned. If this attribute is ustitg MO identifier MUST be
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specified in the Item/Data element within the GBMmemand

MORootData The roots of all MO occurrences corresiing to the specified MO
identifier along with the requested Leaf Node’sadatd URI are returned. [f
this attribute is used, the MO identifier appendéth “?” and the requested
Leaf Node’s URI relative to the MO Root MUST be sified in the
Item/Data element within the GET command. Only beaf Node can be
requested.

Table5: Possible attributes for M anagement Treeinformation retrieval

8.2 Representation Response of the Management Tree

Representing the tree using multipiem elements inside the OMA DRResult command is the simplest approach.
Requested information from the Node (URI in the Gahmand with attribute) is embedded intdt@m inside aResult
command with the following requirements (See afepdxamples in the Appendix C):

e Sruct attribute -Meta MUST be used to indicate tAggpe andFormat of the Node, unless thgype and
Format have the default values [METAJocURI inside theSource MUST indicate the URI of the Node.

e SructData attribute -Meta MUST be used to indicate tAgpe andFormat of the Node, unless thieype and
Format have the default values [METAJocURI inside theSource MUST indicate the URI of the Node. Leaf
Node data MUST be included to thata element.

* TNDSattribute -METAMUST be used to indicate tigpe andFormat as defined in [DMTNDS]LocURI
inside theSource  MUST indicate the URI of the starting Node. If extra attributes are included after “TNDS”
the device SHOULD include all valid properties ttet server has access rights to receive. Optiotied server
MAY request which properties that only SHOULD belirded in the Serialized management sub-tree \dangd
“+" and the property name. More than one propedama are allowed in the list. The server MAY alsolade
some properties from the default, all property-N$a adding a “-“character followed by the progyarame. It is also
possible to add multiple “-PropertyName” after eater. The include property “+” and remove propértare not
possible to combine in the same Get command. \Raligherty names are all properties defined in chidofein
[DMTNDS] which are inside “RTProperties” and additally the “Value” property. The Client MUST retugtatus
Code “406 Optional feature not supported” if th@ide does not support TNDS or anyone of the pregergerties
in the presented list.
Example on valid property list: “?list=TNDS+Value€A" for only data and ACL or “?list=TNDS-Format” ffall
supported properties except the Format Property.

*  MOROoot attribute -Meta MUST be used to indicate tigpe andFormat of the Node, unless thigype and
Format have the default values [METAJocURI inside theSource MUST indicate the MO occurrence’s root.

* MORootData attribute - Meta MUST be used to indicate the Tgpd Format of the Node, unless the Type and
Format have the default values [META]. The DM Cti®étlUST return two Items for each instance of MOrfdun
the DM Tree - one Item for the URI of the instarmeg one Item for the Leaf Node data of the ingafor the
Item containing the URI, the Source/LocURI MUSTigate the MO occurrence’s root. For the Item caritej the
Leaf Node data, the requested Leaf Node’s URI M8Etored in the Source/LocURI, and the Leaf Nodiata
MUST be stored in the Data element.

For Sruct andStructData this information from the requested Nodes MAY beluded into a multipltem elements
inside aResult command or there MAY be multipResult commands with singleem .
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9. Device Description Framework

9.1 Rationale for a Device Description Framework

In an ideal world all devices would display the sastructure and behavior to a management systetisife different
vendors are competing with each other on the méoketarious kinds of devices, it seems very uriikbat this would ever
happen. But management systems still need to uagereach individual device even though they deeapfo have
different internal structures and behaviors.

To address this issue the concept of a device igéiscrframework is introduced. In short this framark prescribes a way
for device vendors to describe their devices sbalhmanagement system can understand how to mémagdevice. The
following figure illustrates the principle.

DTD ?? f
lStructure
| — Content
Device <
model
(XML) '
Structure
Configuration Content
document ~—
(XML)

@

Managed device

Figure 3: Conceptual view of how a description framework is used

By using a description framework we also make saethe total management system based on OMA Dibiible and
easily extendible. And that it can accommodateomby the demands we put on it today but also thesame might have
tomorrow. We also avoid a situation where all fetaranagement needs would have to be standardifee ey could be
used in devices to simplify the use of these device

It is important to note that the description franoekvneeds to co-exist with the existing standawdliZanagement Objects,
and that the borderline between the standardizethlylement Objects and Management Objects descrbtu: framework
will change over time. This will mainly happen whestandards body decides to create specificatiodow their
technology should be managed. It is in the inteséte OMA Device Management committee to encoeiragd support
such initiatives from standard bodies active ineléiss standardization, so that the set of starmtaddlanagement Objects
increases.
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9.2 The OMA DM Device Description Framework

Today there exist a number of different descripframeworks, but none of these seem to suit theqaas of OMA DM.
There are also activities in other standards bdtiigsaim to develop new frameworks specificallytfoe wireless industry.
With this in mind, OMA DM does currently not spgcthe use of any particular framework.

However, the need for a description framework reimaind therefore OMA DM RECOMMENDS using the follog/
simple framework as an interim solution. This preg description framework is defined by an XML DTescriptions of
Management Objects, or complete Management Treesatid XML documents. Device manufactures ushegy
description framework MUST make the device desiiyst available to DM Servers. The mechanism fa ihicurrently not
being standardized.

The OMA DM Device Description Framework DTD is defd in [DMDDFDTD].

9.3 XML usage

The OMA DM DDF information XML documents are spéeif using well-formed XML. However, they MAY not balid
XML. That is, they do not need to specify the XMiolpg. They only need to specify properly identifieame space
element types from the OMA DM DDF information DTDhis restriction allows for the OMA DM DDF informiah to be
specified with greater terseness than would beilplesi$ a well-formed, valid XML document was REQRED.

This DTD makes heavy use of XML name spaces. Ngraees MUST be declared on the first element typeubkes an
element type from the name space.

Names in XML are case sensitive. The element tipdse OMA DM DDF information DTD are defined in DDFDTD]
or the URN syncml:dmddf.

OMA DM also makes use of XML standard attributegtsas xml:lang. Any XML standard attribute caruged in a XML
document conforming to this DTD.

9.4 Framework Elements

This section explains the elements used in therig¢isn framework DTD.

9.4.1  Structural elements

These elements provide various kinds of structuafafrmation of the described Management Object.
9.4.1.1 MgmtTree

Usage: Container for one or more described Manage®iejects.

Parent Elements: none

Restrictions: This MUST be the root element ofd@écriptions.

Content Model(VerDTD, Man?, Mod?, Node+)

9.4.1.2 VerDTD

Usage: Specifies the major and minor version ifientbof the OMA DM Description Framework specifizat used to
represent the OMA DM description.

Parent ElementdigmtTree

Restrictions: Major revisions of the specificatineate incompatible changes that will generallyinega new parser. Minor
revisions involve changes that do not impact besiopatibility of the parser. When the XML documeatforms to this

0 2010 Open Mobile Alliance Ltd. All Rights Reserved.
Used with the permission of the Open Mobile Alliance Ltd. under the terms as stated in this document.



OMA-TS-DM_TND-V1_3-20100525-C Page 28 (52)

revision of the OMA DM Device Description Framewdhe value MUST bé&.2 . The element type MUST be included in
theMgmtTree .

Content Model(#PCDATA)
9.4.1.3 Man

Usage: Specifies the manufacturer of the device.
Parent ElementdvigmtTree
Restrictions: This element is OPTIONAL.

Content Model(#PCDATA)

9.4.1.4 Mod

Usage: Specifies the model number of the device.
Parent ElementdMgmtTree

Restrictions: This element is OPTIONAL.

Content Model(#PCDATA)
9.4.1.5 Node
Usage: Specifies a Node.
Parent ElementdvigmtTree

Restrictions: This element is recursive. A NodehveitValue element MUST always terminate the reoutdt is possible for
a Node to omit both the next recursive Node andilai&/ this means that the hierarchy of Nodes coasirelsewhere. This
can be used to increase readability of very desgstrin the continuation, the Path element MUSTatora full URI that
specifies the insertion point in the tree.

Content Model(NodeName, Path?, RTProperties?, DFProperties?, (No de*|Value?))

Example: The following XML is a description of amber of Nodes that form the URkndor/ISP/GWInfo/GWName
Note that all the details of DFProperties are dghitely left out.

<MgmtTree>
<Node>
<NodeName>Vendor</NodeName>
<DFProperties>...</DFProperties>
<Node>
<NodeName>ISP</NodeName>
<DFProperties>...</DFProperties>
<Node>
<NodeName>GWInfo</NodeName>
<DFProperties>...</DFProperties>
<Node>
<NodeName>GWName</NodeName>
<DFProperties>...</DFProperties>
<Value>gw.yyy.se</Value>
</Node>
</Node>
</Node>
</Node>
</MgmtTree>
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9.4.1.6 NodeName
Usage: Specifies the name of the described Node.
Parent Elementd&lode

Restrictions: See [RFC2396] for general restriction URI. The NodeName element MAY be empty. If gmihis means
that the name of the Node MUST be assigned wheNdle is created. When the Node name is assign¥dds creation
time, the value for the name is set to the lastneety of the URI specified as Target for the commiduad results in the Node
being created. See also section 7.7.3.

Content Model(#PCDATA)

9.4.1.7 Path
Usage: Specifies the URI up to, but not includithg, described Node.
Parent Elementdlode

Restrictions: OPTIONAL element. If omitted, the Ufdt the Node MUST be constructed by concatenatlhgncestral
NodeName and Path values. This concatenated vall&Morm the correct URI. Path SHOULD only be ugeide Node
elements that are child elements to the MgmtTremeht. For general restrictions, see [RFC2396].

Content Model(#PCDATA)

Example: The following XML is an alternative waydescribe the same Management Objects as in tmepgan section
9.4.1.5. This description specifies the same URhaother examplé/endor/ISP/GWInfo/GWName.  Note that all the
details of DFProperties are deliberately left out.

<MgmtTree>

<Node>
<NodeName>Vendor</NodeName>
<DFProperties>...</DFProperties>

</Node>

<Node>
<NodeName>ISP</NodeName>
<Path>Vendor</Path>
<DFProperties>...</DFProperties>

</Node>

<Node>
<NodeName>GW!Info</NodeName>
<Path>Vendor/ISP</Path>
<DFProperties>...</DFProperties>

</Node>

<Node>
<NodeName>GWName</NodeName>
<Path>Vendor/ISP/GWInfo</Path>
<DFProperties>...</DFProperties>
<Value>gw.yyy.se</Value>

</Node>

</MgmtTree>

9.4.1.8 Value
Usage: Specifies a default value for Nodes thatretentiated using the current description.
Parent ElementdJdode

Restrictions: OPTIONAL element. If omitted, the Modescription does not specify any default valugtfe Node. In this
case the initial value of new Nodes is undefined.
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Content Model(#PCDATA)

9.4.1.9 RTProperties

Usage: Aggregating element for run-time properiies properties that the Nodes have in a devicaratime. Used to
specify which properties the described Node supmatirtun-time. Can also be used to supply defalltes for supported
run-time properties.

Parent ElementfNode

Restrictions: OPTIONAL element. If omitted, the NoRIUST only support the mandatory run-time progsrACL,
Format, Name and Type. If any optional propertressaipported, they MUST be specified by using ¢lesnent.

Content Model{ACL?, Format?, Name?, Size?, Title?, TStamp?, Typ e, VerNo?)
9.4.1.10 DFProperties

Usage: Aggregating element for description framéwmwpperties, i.e. properties that Nodes have éndisscription
framework and that are not explicitly present at-time.

Parent Elementd\lode
Restrictions: This is a REQUIRED element.

Content Model{AccessType, DefaultValue?, Description?, DFFormat, Occurrence?, Scope?,
DFTitle?, DFType, CaseSense?)

9.4.2 Run-time property elements

The usage of the run-time properties in the desorigramework reflects the mandatory/optionalssatf the corresponding
run-time property. These elements can also be tasdescribe default values for the supported piteserSince these
properties can change at run-time, the valuesadelproperties in the description and in a reaicéewill differ.

TheRTProperties element, which encapsulates the run-time propeiie@8PTIONAL within its parent elemehtode .
The purpose of this is to make it possible to dh®#tRTProperties element if only the mandatory properties are
supported and there is no need to specify any tefalues. If theRTProperties element is used in a description, all the
mandatory run-time properties MUST be specified.

9421 ACL

Usage: Specifies support for the ACL property. MB¥ used to specify a default value for the property
Parent ElementRTProperties

Restrictions: If a value is specified it MUST berfatted according to section 7.7.1.5.

Content Model(#PCDATA)

9.4.2.2 Format

Usage: Specifies support for the Format propert&YMbe used to specify a default value for the prope
Parent ElementRTProperties

Restrictions: If a default value is specified foetdescribed Node, the Format property MUST spehiycorrect format of
the Node value.

Content Model{b64 | bin | bool | chr | int | node | null | xml | date |time [float)
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9.4.2.3 Name

Usage: Specifies support for the Name property. MgYused to specify a default value for the prop&tarent Elements:
RTProperties

Restrictions: See [RFC2396]. If a default propediue is specified, it SHOULD be the same as tteevaf theNodeName
element.

Content Model(#PCDATA)
9.4.2.4 Size

Usage: Specifies support for the Size property. M#eYused to specify a default value for the prgpéKithin its parent
element, th&ize element is defined as optional. Size MUST NOT sedufor Interior Nodes. In Node elements describing
Leaf Nodes th&ize element MAY be used withiRTProperties

Parent Element®RTProperties

Restrictions: If a value is specified it MUST berfatted according to section 7.4.

Content Model(#PCDATA)

9.4.25 Title

Usage: Specifies support for the Title property. ¥lBe used to specify a default value for the proper
Parent ElementRTProperties

Restrictions: If a value is specified it MUST berfatted according to section 7.4.

Content Model(#PCDATA)

9.4.2.6 TStamp

Usage: Specifies support for the TStamp properéYNde used to specify a default value for the prope
Parent ElementRTProperties

Restrictions: If a value is specified it MUST berfatted according to section 7.4.

Content Model(#PCDATA)

9.4.2.7 Type

Usage: Specifies support for the Type property. M#erused to specify a default value for the prgpert
Parent ElementRTProperties

Restrictions: For Leaf Nodes, if a default valuspecified for the described Node, the Type progpdt/ST be used to
specify the correct MIME type of the Node’s presesitie using a single MIME element. For Intericvdés a DDFName
element MUST be present and specify a valid Managei@bject identifier, which MAY be empty.

Content Model(MIME | DDFName)

9.4.2.8 VerNo

Usage: Specifies support for the VerNo property.YWi#e used to specify a default value for the proper
Parent ElementRTProperties

Restrictions: If a value is specified it MUST berfatted according to section 7.4.
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Content Model(#PCDATA)

9.4.2.9 b64

Usage: OMA DM format description. Specifies tHa tNode value is Base64 encoded.
Parent Element$:ormat, DFFormat

Restrictions: None.

Content ModelEMPTY

9.4.2.10 bin

Usage: OMA DM format description. Specifies tHa Node value is binary data.
Parent Element$:ormat, DFFormat

Restrictions: None.

Content ModelEMPTY

9.4.2.11 bool

Usage: OMA DM format description. Specifies that tiiode value is a Boolean.
Parent Element$:ormat, DFFormat

Restrictions: None.

Content ModelEMPTY

9.4.2.12 chr

Usage: OMA DM format description. Specifies that ttiode value is text.

Parent Element$:ormat, DFFormat

Restrictions: The character set used is speciftbéreby the transport protocol, MIME content typeader or XML
prologue.

Content ModelEMPTY

9.4.2.13 int

Usage: OMA DM format description. Specifies tha tode value is a 32-bit signed integer.
Parent Element$:ormat, DFFormat

Restrictions: None.

Content ModelEMPTY

9.4.2.14 node

Usage: OMA DM format description. Specifies that tiode is an Interior Node.

Parent Element$:ormat, DFFormat

Restrictions: This Format MUST only be used foetidr Nodes.
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Content ModelEMPTY

9.4.2.15 null

Usage: OMA DM format description. Specifies tha thode value is null.
Parent Element$:ormat, DFFormat

Restrictions: None.

Content ModelEMPTY

9.4.2.16 xml

Usage: OMA DM format description. Specifies tha tode value is XML data.
Parent Element$:ormat, DFFormat

Restrictions: None.

Content ModelEMPTY

9.4.2.17 date

Usage: OMA DM format description. Specifies that tiode value is a date in ISO 8601 format withddetury being
included in the year [ISO8601].

Parent Element$ormat, DFFormat
Restrictions: None.

Content ModelEMPTY

9.4.2.18 time

Usage: OMA DM format description. Specifies that tiode value is a time in ISO 8601 format [ISO8601]
Parent Element$ormat, DFFormat

Restrictions: None.

Content ModelEMPTY

9.4.2.19 float

Usage: OMA DM format description. Specifies tha tode value is a real number corresponding toglesiprecision 32
bit floating point type as defined in XML Schem@ &s thdloat  primitive type [XMLSCHEMADT].

Parent Element$:ormat, DFFormat

Restrictions: None.

Content ModelEMPTY

9.4.2.20 MIME

Usage: Specifies the MIME type of the current Nudkie.
Parent ElementSiype, DFType

Restrictions: MUST only contain valid MIME type idkifiers. See [META].

0 2010 Open Mobile Alliance Ltd. All Rights Reserved.
Used with the permission of the Open Mobile Alliance Ltd. under the terms as stated in this document.



OMA-TS-DM_TND-V1_3-20100525-C Page 34 (52)

Content Model(#PCDATA)

9.4.2.21 DDFName

Usage: Specifies the Management Object Identifi¢he Management Object rooted at this Node, enipty.
Parent ElementSype, DFType

Restrictions: MUST only contain a valid Managem®bject Identifier or be empty. See 7.7.7.2.

Content Model(#PCDATA)

9.4.3 Framework property elements

The properties that described Nodes have in theriggisn framework are specified with framework pesty elements.
These are not the same as the run-time propeftass instantiated Node in a device. These proedig@ress other
information about Nodes that DM Servers might ngédm: framework properties MUST NOT change at rametsince such
a change might introduce discrepancies betweerutiime Node and the corresponding descriptiore fblowing table
defines the framework Node properties.

Element/Property Explanation Usage

AccessType Specifies which commands are allowed orMUST
the Node.

DefaultValue The Node value used in a device unless | MAY
specifically set to a different value.

Description The human readable description of the | MAY
Node.

DFFormat The data format of the described Node. MuUS

Occurrence Specifies the number of instances tliet M MAY
occur of the Node.

Scope Specifies whether this is a permanent or | MAY
Dynamic Node.

DFTitle The human readable name of the Node. MAY

DFType For Leaf Nodes, the MIME type of the NodMUST
value.
For Interior Nodes, a Management Object
Identifier or empty.

CaseSense Specifies whether the Node name and rjaay
of descendant Nodes in the tree below
should be treated as case sensitive or case
insensitive.

Table 6: Framework property elements

9.4.3.1 AccessType

Usage: Specifies which commands are supportedhéodéscribed Node. This property is independetit@ACL run-time
property.

Parent Element®FProperties

Restrictions: The value of this property MUST beuaordered list of the valid OMA DM commands.

Content Model{Add?, Copy?, Delete?, Exec?, Get?, Replace?)
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9.4.3.2 DefaultValue

Usage: Specifies the “factory default” value of thede, if such a value exists.

Parent Element®FProperties

Restrictions: The MIME type of the value MUST capend with the MIME type specified by the DFTypemerty.
Content Model(#PCDATA)

9.4.3.3 Description

Usage: A human readable description of the destiimle. This is used to convey any relevant inféimnaregarding the
Node that is not explicitly given by the other peojes.

Parent Element®FProperties

Restrictions: Descriptions SHOULD be kept as sherpossible.

Content Model(#PCDATA)

9.43.4 DFFormat

Usage: Specifies the data format of the describedieN

Parent Element®FProperties

Restrictions: For Interior Nodes the Format MUSThbele .

Content Model(b64 | bin | bool | chr | int | node | null | xml | date | time | float)
9.4.3.5 Occurrence

Usage: Specifies the potential number of instatitaisMAY occur of the described Node.

Parent Element®FProperties

Restrictions: If the property is omitted the Noaewrrence is exactly one.

Content Model(One | ZeroOrOne | ZeroOrMore | OneOrMore | ZeroOrN | OneOrN)
9.4.3.6 Scope

Usage: Specifies whether the described Node is &&nt or Dynamic.

Parent Element®FProperties

Restrictions: The value is indicated by the tBgsmanent andDynamic in the description framework. This property is
OPTIONAL, if omitted the described NodeDgnamic .

Content Model{Permanent | Dynamic)

9.4.3.7 DFTitle

Usage: A human readable name for the Node desuripti

Parent Element®FProperties

Restrictions: Titles SHOULD be kept as short aridrimative as possible.

Content Model(#PCDATA)
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9.4.3.8 DFType

Usage: For Leaf Nodes, one or more elements spiafiviiME types the described Node supports. Farior Nodes, a
single MIME element MUST specify be present anccgpa valid Management Object Identifier, which MAe empty.

Parent Element®FProperties

Restrictions: Note that a Leaf Node can supportipial MIME types, e.g. a ring signal Node might pag both audio/mpeg
and audio/MP4-LATM. The values of tidType property MUST be registered MIME types.

Content Model{MIME+ | DDFName)

9.4.3.9 Add

Usage: Specifies support for the OMA DM Add command
Parent Element#iccessType

Restrictions: None.

Content ModelEMPTY

9.4.3.10 Copy

Usage: Specifies support for the OMA DM Copy comcthan
Parent Element#ccessType

Restrictions: None.

Content ModelEMPTY

9.4.3.11 Delete

Usage: Specifies support for the OMA DM Delete caanch
Parent Element#ccessType

Restrictions: None.

Content ModelEMPTY

9.4.3.12 Exec

Usage: Specifies support for the OMA DM Exec comdian
Parent Element#ccessType

Restrictions: None.

Content ModelEMPTY

9.4.3.13 Get

Usage: Specifies support for the OMA DM Get command
Parent Element#ccessType

Restrictions: None.

Content ModelEMPTY
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9.4.3.14 Replace

Usage: Specifies support for the OMA DM Replace ig@md.

Parent Element#ccessType

Restrictions: None.

Content ModelEMPTY

9.4.3.15 One

Usage: Specifies that the described Node can @@atly one (1) time.
Parent Element$ccurrence

Restrictions: None.

Content ModelEMPTY

9.4.3.16 ZeroOrOne

Usage: Specifies that the described Node can aither one (1) time or not at all.

Parent Element®ccurrence

Restrictions: None.

Content ModelEMPTY

9.4.3.17 ZeroOrMore

Usage: Specifies that the described Node can @tunspecified number of times, or not occur at all

Parent Element®ccurrence

Restrictions: None.

Content ModelEMPTY

9.4.3.18 ZeroOrN

Usage: Specifies that the described Node can @gunumber times up to N times, or not occur at all

Parent Element®ccurrence

Restrictions: N MUST be specified as a charactangtepresenting a positive integer value betw2eand 65536.
Content Model(#PCDATA)

9.4.3.19 OneOrMore

Usage: Specifies that the described Node can @tunspecified number of times, but MUST occueast once.
Parent Element$ccurrence

Restrictions: None.

Content ModelEMPTY
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9.4.3.20 OneOrN

Usage: Specifies that the described Node can @ounumber times up to N times but MUST occur ast®nce.
Parent Element®ccurrence

Restrictions: N MUST be specified as a charactangtepresenting a positive integer value betw2and 65536.
Content Model(#PCDATA)

9.4.3.21 Dynamic

Usage: Specifies that the described Node is Dynamic

Parent ElementsScope

Restrictions: None.

Content ModelEMPTY

9.4.3.22 Permanent

Usage: Specifies that the described Node is Pemmbane
Parent ElementsScope

Restrictions: None.

Content ModelEMPTY

9.4.3.23 CaseSense

Usage: Specifies whether the Node name and nanteEsoéndant Nodes in the tree below SHOULD beddea$ case
sensitive or case insensitive.

Parent Element®FProperties

Restrictions: MUST only contain value CS or CIS.

Content Model(CS | CIS)

9.4.3.24 CS

Usage: Case sensitivity declaration. Specifies¢hdd Node names MUST be treated as case sensitive
Parent Element£aseSense

Restrictions: None.

Content ModelEMPTY

9.4.3.25 CIS

Usage: Case insensitivity declaration. Specifias thild Node names MUST be treated as case insensi
Parent Element£aseSense

Restrictions: None.

Content ModelEMPTY
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9.5 Shortcomings of the OMA DM description framework

It is not possible to specify that only one Nodeaofallowed set can be instantiated at a time. Goenpith the DTD
construct (A | B), this is currently described bgkimg both A and B optional, but there is no waydpresent that they are
mutually exclusive. However, this is mostly a perhalthat occurs when mapping existing Managemengéd@bpnto the
description framework. When new Management Objatdesigned for the framework, this situation lsaravoided.
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10.WB XML Definition

The following tables define the token assignmeaistie mapping of the DMDDF related DTDs and elehtgoes into
WBXML as defined by [WBXML1.1], [WBXML1.2], [WBXML13].

10.1 Code Page Definitions

The following code page tokens represent DM DDHiputlentifiers. This version of the DM protocolegification utilizes
the WBXML code page tokens for identifying DTDs.

DTD Name WBXML Code Page Formal Public | dentifier
Token (Hex Value)
DMDDF 02 -//OMA//DTD-DM-DDF 1.2//EN

Table 7: Code pagetokens

10.2 Token Definitions

The following WBXML token codes represent elemempes (i.e., tags) from code page x02 (two), OMA DRIF DTD.

Element Type Name WBXML Tag Token (Hex Value)
AccessType 05
ACL 06
Add 07
b64 08
bin 09
bool 0A
chr 0B
CaseSense ocC
CIS 0D
Copy OE
Cs OF
date 10
DDFName 11
DefaultValue 12
Delete 13
Description 14
DFFormat 15
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DFProperties 16
DFTitle 17
DFType 18
Dynamic 19
Exec 1A
float 1B
Format 1C
Get 1D

int 1E

Man 1F
MgmtTree 20
MIME 21
Mod 22
Name 23
Node 24
node 25
NodeName 26
null 27
Occurrence 28
One 29
OneOrMore 2A
OneOrN 2B
Path 2C
Permanent 2D
Replace 2E
RTProperties 2F
Scope 30
Size 31
time 32
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Title 33
TStamp 34
Type 35
Value 36
VerDTD 37
VerNo 38
xml 39
ZeroOrMore 3A
ZeroOrN 3B
ZeroOrOne 3C

Table 8: Token definitions
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Appendix B. Static Conformance Requirements
The notation used in this appendix is specified@PPROC].

B.1 SCR for DM Client

Item Function Reference | Status | Requirement

DMTND-Prop-C-001 Support for the ACL property 7.2 M

DMTND-Prop-C-002 Support for the Format 7.2 M
property

DMTND-Prop-C-003 Support for the Name 7.2 M
property

DMTND-Prop-C-004 Support for the Size property7.2 O
in Leaf Nodes

DMTND-Prop-C-005 No support for the Size 7.2 M
property in Interior Nodes

DMTND-Prop-C-006 Support for the Title property 7.2 @)

DMTND-Prop-C-007 Support for the TStamp 7.2 O
property

DMTND-Prop-C-008 Support for the Type 7.2 M
property

DMTND-Prop-C-009 Support for the VerNo 7.2 O
property

DMTND-Prop-C-010 Support Get?list=Struct 8.1 (0]

DMTND-Prop-C-011 Support Get?list=StructData 8.1 0]

DMTND-Prop-C-012 Support Get?list=TNDS 8.1 (0]

DMTND-Prop-C-013 Support Get?list=MORoot 8.1 o]

DMTND-Prop-C-014 Support 8.1 O
Get?list=MORootData

B.2 SCR for DM Server

Item Function Reference | Status | Requirement

DMTND-Prop-S-001 Support for the ACL property 7.2 M

DMTND-Prop-S-002 Support for the Format 7.2 M
property

DMTND-Prop-S-003 Support for the Name 7.2 M
property

DMTND-Prop-S-004 Support for the Size propertyr.2 M
in Leaf Nodes

DMTND-Prop-S-005 No support for the Size 7.2 M
property in Interior Nodes

DMTND-Prop-S-006 Support for the Title property 7.2 M

DMTND-Prop-S-007 Support for the TStamp 7.2 M
property

DMTND-Prop-S-008 Support for the Type 7.2 M
property

DMTND-Prop-S-009 Support for the VerNo 7.2 M
property

DMTND-Prop-S-010 Support Get?list=Struct 8.1 0]

DMTND-Prop-S-011 Support Get?list=StructData 8.1 (@)
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Item Function Reference | Status | Requirement
DMTND-Prop-S-012 Support Get?list=TNDS 8.1 0]
DMTND-Prop-S-013 Support Get?list=MORoot 8.1 0]
DMTND-Prop-S-014 Support 8.1 O

Get?list=MORootData
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Appendix C. Tree Exchange Examples (Informative)

In the examples below the DM client has a followiignagement Tree.

! .
X Root 1 Properties
! . i Interior node
N ,'
Properties B Properties
A Interior node Leaf node
Integer
Properties Properties
C Interior node D Interior node

Properties
F Leaf node
XML document

Properties
E Interior node

Properties
G Leaf node
String

Properties
H Leaf node
Binary data

Figure 4. Example Management Tree

C.1 Example of a Get with Attribute Struct

In the example below DM server requests a Managefiree structure from a client.

<Get>
<CmdID>4</CmdID>
<|tem>
<Target>
<LocURI>./A ?l i st =St ruct </LocURI>
</Target>
</ltem>
</Get>

Client response usirigesult and multipleltem elements.

<Results>
<CmdRef>4</CmdRef>
<CmdID>7</CmdID>
<ltem>
<Meta>
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<Format xmIns="syncml:metinf’>node</Format>
</Meta>
<Source>
<LocURI>./A</LocURI>
</Source>
</ltem>
<|tem>
<Meta>
<Format xmIns="syncml:metinf’>node</Format>
</Meta>
<Source>
<LocURI>./A/C</LocURI>
</Source>
</ltem>
<|tem>
<Meta>
<Format xmIns="syncml:metinf’>node</Format>
</Meta>
<Source>
<LocURI>./A/D</LocURI>
</Source>
</ltem>
<|tem>
<Meta>
<Format xmIns="syncml:metinf’>node</Format>
</Meta>
<Source>
<LocURI>./A/D/E</LocURI>
</Source>
</ltem>
<|tem>
<Meta>
<Format xmIns="syncml:metinf’>xml</Format>
</Meta>
<Source>
<LocURI>./A/D/F</LocURI>
</Source>
</ltem>
<|tem>
<Source>
<LocURI>./A/D/E/G</LocURI>
</Source>
</ltem>
<|tem>
<Meta>
<Format xmIns="syncml:metinf’>b64</Format>
</Meta>
<Source>
<LocURI>./A/D/E/H</LocURI>
</Source>
</ltem>
</Results>

C.2 Example of a Get with Attribute StructData

In the example below DM Server requests a Manageiiee structure as well as the data from a client.
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<Get>
<CmdID>4</CmdID>
<|tem>
<Target>
<LocURI>./A/D ?1 i st =St ruct Dat a</LocURI>
</Target>
</ltem>
</Get>

Client response usir@esult and multipleltem elements.

<Results>
<CmdRef>4</CmdRef>
<CmdID>7</CmdID>
<|tem>
<Meta>
<Format xmIns="syncml:metinf’>node</Format>
</Meta>
<Source>
<LocURI>./A/D</LocURI>
</Source>
</ltem>
<ltem>
<Meta>
<Format xmIns="syncml:metinf’>node</Format>
</Meta>
<Source>
<LocURI>./A/D/E</LocURI>
</Source>
</ltem>
<|tem>
<Meta>
<Format xmIns="syncml:metinf’>xml</Format>
</Meta>
<Source>
<LocURI>./A/D/F</LocURI>
</Source>
<Data>'XML document’</Data>
</ltem>
<ltem>
<Source>
<LocURI>./A/D/E/G</LocURI>
</Source>
<Data>leaf node data</Data>
</ltem>
<|tem>
<Meta>
<Format xmiIns="syncml:metinf’>b64</Format>
<Type xmins="syncml:metinf’>image/jpeg</Type>
</Meta>
<Source>
<LocURI>./A/D/E/H</LocURI>
</Source>
<Data>JSCNMDTUVWXY Zcuokcdghfidjssatu</Data>
</ltem>
</Results>
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C.3 Example of a Get with Attribute MORoot

In the examples below the DM client has a followiignagement Tree.

\

Root | Properties
: Interior node
1

Figure5: Example of Get with Attribute M ORoot

In the example below DM server requests roots of ddC@urrences from a client.

<Get>
<CmdID>4</CmdID>
<|tem>
<Target>
<LocURI>. ?1'i st =MORoot </LocURI>
</Target>

<Data>urn:oma:mo:oma-example:1.0</Data>
</ltem>
</Get>

Client response usirgesult and multipleltem elements.

<Results>
<CmdRef>4</CmdRef>
<CmdID>7</CmdID>
<|tem>
<Meta>
<Format xmIns="syncml:metinf’>node</Format>
</Meta>
<Source>
<LocURI>./A/C</LocURI>
</Source>
</ltem>

A Properties B | Properties
Interior node Leaf node
Integer
Properties Properties
C Interior node D | Interior node
Type: urn:oma:mo:oma-example:1.0 Type: urn:oma:mo:oma-example:1.0
E Properties = Properties E Properties Properties
Interior node Leaf no Interior node Leaf node
String String
G Properties G Properties
Leaf node Leaf node
String String
H Properties H Properties
Leaf node Leaf node
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<|tem>
<Meta>
<Format xmIns="syncml:metinf’>node</Format>
</Meta>
<Source>
<LocURI>./A/D</LocURI>
</Source>
</ltem>
</Results>

C.4 Example of a Get with Attribute MORootData

In the example below DM server requests roots of ddCurrences of DCMO with specified Leaf Nodes ffady’ data
from a client. The assumption is that nodes ./Ai@ #A/D in the diagram in section C.3 are of type:oma:mo:oma-
dcmo:1.0’ and nodes .JA/C/F and ./A/D/F are aciudile ‘Property’ leaf nodes of DCMO.

<Get>
<CmdID>4</CmdID>
<|tem>
<Target>
<LocURI>. ?1 i st =MORoot Dat a</LocURI>
</Target>

<Data>urn:oma:mo:oma-dcmo:1.0?/Property</Data>
</ltem>
</Get>

Client response usirigesult and multipleltem elements.

<Results>
<CmdRef>4</CmdRef>
<CmdID>7</CmdID>
<ltem>
<Meta>
<Format xmIns="syncml:metinf’>node</Format>
</Meta>
<Source>
<LocURI>./A/C</LocURI>
</Source>
</ltem>
<ltem>
<Meta>
<Format xmIns="syncml:metinf’>chr</Format>
</Meta>
<Source>
<LocURI>./A/C/Property</LocURI>
</Source>

<Data>Camera</Data> <!-- this is camera -->
</ltem>
<ltem>
<Meta>
<Format xmIns="syncml:metinf’>node</Format>
</Meta>
<Source>
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<LocURI>./A/D</LocURI>
</Source>
</ltem>
<ltem>
<Meta>
<Format xmIns="syncml:metinf’>chr</Format>
</Meta>
<Source>
<LocURI>./A/D/Property</LocURI>
</Source>

<Data>Bluetooth</Data> <!-- this is Bluetoot h-->
</ltem>
</Results>
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Appendix D. Type definitions (Normative)
D.1 MIME Media Type Definition

MIME Type Description

application/vnd.syncml.dmddf+xml XML encoded DDFcdonent complying to this specification

application/vnd.syncml.dmddf+wbxml WBXML encoded Bldocument complying to this specification
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